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RX72M Group  
CPU Card OPC UA Startup Manual 
Introduction 
This is a quick start guide to running OPC UA (Micro / Nano) Server communications on the RX72M CPU 
Card for evaluating industrial networks. 

 

Target Device 
RX72M Group 

 
 

 

Sample Program 
This sample program uses the evaluation version of the OPC UA stack produced by one of our partners, 
Another-ware Corporation. The stack's major communications specifications are as follows. 

• Communications protocol: Compliant with OPC UA Specifications Release 1.03 
• Transfer protocol : UA-Binary 
• Security policy : None 
 
For purchase of the official version of the stack and the specifications of the sample program, contact 
Another-ware Corporation. 

Another Ware Co., Ltd.: https://www.another-ware.co.jp/ 

 

[Restrictions] 
The evaluation version of the OPC UA stack consists of library files which were built with the functional 
limitations as listed below. This version is only made available for purposes of evaluation. 

• The evaluation stack automatically stops running after 90 minutes. Re-starting the program requires 
resetting the device. 

 
Please note that the evaluation stack cannot be used in commercial products. Purchasing the official version 
of the OPC UA stack is required if it is to be used in a commercial product. 
  

R01AN6750EJ0100 
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1. Operating Environment 
The sample program covered in this manual runs in the environment below. 

 

Table 1.1 Operating Environment 

Item Description 
Board Renesas Electronics RX72M CPU Card 

Model name: RTK0EMXDE0C00000BJ 
CPU RX CPU (RXv3) 
Operating frequency CPU clock (CPUCLK): 240 MHz 
Operating voltage 3.3 V 
Operating modes Single chip mode 
Device requirements R5F572MNDDBD 

• Code flash memory 
Capacity: 4 Mbytes 
ROM cache: 8 Kbytes 

• Data flash memory 
Capacity: 32 Kbytes 

• RAM/extended RAM 
Capacity: 512 Kbytes / 512 Kbytes 

Communications protocol OPC UA (UA-Binary) 
Integrated development environment e2 studio (V7.5.0 or later) with the CC-RX compiler (V3.01.00) 
Emulator (ICE) Renesas Electronics 

On-board emulator E2 On-Board (E2OB) 
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2. Setting up and Connecting the Evaluation Board 
For detailed information on this board, refer to the "RX72M CPU Card with RDC-IC User's Manual" 
(R12UZ0098EJ0100). 

 

Figure 2.1 Configuration of the RX72M CPU Card 

 
 
2.1 CPU Card setting 
Set the jumper pins before powering on the CPU Card. 
 
Using E2OB             : Short the Debugger switching Jumper pin. 
 
 

2.2 Power supply selection 
CPU Card does not have DC Jack, input DC5V from USB connector. 
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3. Installing the e2 studio 
Download the e2 studio for RX72M (V7.5.0 or later) from the Web site below. 

https://www.renesas.com/e2studio_download 
 

3.1 Installing the CC-RX Compiler V3.01.00 
The compiler selection dialog box appears while installing the e2 studio. Click [Renesas CCRX v3.01.00] and 
select [Next]. CC-RX V3.01.00 Compiler for RX72M will be installed with the e2 studio. 

 

 

To start the e2 studio, execute "e2studio.exe" in the following installation folder. 

e2_studio_rx72m\eclipse 
 

3.2 How to check the registered Compiler 
(1) Start the e2 studio. 
 
(2) Select [File] → [New] → [C/C++Project] → [Next].  

 

  

https://www.renesas.com/e2studio_download
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(3) In the [Templates for New C/C++ Project] dialog box, select [Renesas RX] → [Renesas CC-RX  C/C++ 
Executable Project] → [Next].  

 

 
(4) In the [New Renesas CC-RX C/C++ Executable Project] dialog box, enter a desired project name and 

select [Next]. 

 

(5) In the [Select toolchain, device & debug settings] dialog box, select [Manage Toolchains...] under 
[Toolchain Settings]. 

 

(6) In the [Renesas Toolchain Management] dialog box, the registration was successful if "v3.01.00” has 
been added under "Renesas CCRX". 
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4. Connections 
 
(1) Connect an Ethernet cable (category 5 or higher recommended) to the Ether port (CN8 IN). 

For detailed connection configuration, refer to "7.1.1 Connection configuration". 
 

(2) Connect the emulator and power supply common USB connector to the host computer via USB. 
 
 

Note): Not use E2OB and run in ROM mode, remove the Debugger switching Jumper pin. 
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5. Importing a Sample Project to the e2 studio 
(1) Extract the archived sample project and store it in any folder. 
             
(2) Select [File] → [Import]. 
 
(3) In the [Select] dialog box, select [General] → [Existing Projects into Workspace] and select [Next]. 

 

 
(4) In the [Import Projects] dialog box, check the "Select archive file:" button, then select [Browse...]. 
 
(5) Select the "opcuaserver_RX72M" folder of the sample project stored in any folder in (1), and select 

[Open]. 

 
 
Check "RX72M_DnetSlave(RX72M_DnetSlave/)" under the "Projects" label and select [Next]. The project 
will be imported into the workspace. 
 
  

any folder 
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6. Programming and Debugging 
(1) Select the "opcuaserver_RX72M" project in the Project Explorer view. Select the arrow next to the build 

button (hammer icon) and select [HardwareDebug] from the drop-down menu.  

 

 
 

(2) e2 studio will build the project. After the build is completed, select the arrow next to the debug button 
(bug icon). You can start debugging by selecting [Debug Configurations...].  

 

 
 
(3) Set up E2OB. E2OB functions as an emulator equivalent to E2Lite, so when connecting, set the 

emulator type to "E2Lite" and the communication interface to "FINE". 
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(4) Select the file " opcuaserver_RX72M HardwareDebug" and download the program to the target device. 

Click on the [Debug] button to start debugging.  

 

 

(5) If a firewall warning is displayed for "e2-server-gdb.exe", check the checkbox for [Private networks, such 
as my home or work network] and select [Allow access]. 

 

(6) The User Account Control (UAC) dialog box may appear. Enter the administrator's password and select 
[Yes]. 

 

(7) If the Confirm Perspective Switch dialog box appears prompting you to switch the perspective, check 
the checkbox for [Remember my decision] and select [Yes]. 

 

(8) The green "ACT" LED on the E2 Lite debugger will be continuously lit. 

 

After downloading the code, select the [Resume] button to run the code. The code will break at the address 
where the main function starts. Select the [Resume] button again to continue to run the code. 
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7. Appendix 
7.1 Verifying Operation of the Sample Program 
Operation of the sample program can be verified as follows. 

 

7.1.1 Configuration of Connections 

 

Figure 7.1 Configuration of Connections 
 

Table 7.1 List of Devices 

Item Description 
OPC UA Server device Renesas Electronics RX72M CPU Card 

Model name: RTK0EMXDE0C00000BJ 
PC software dataFEED OPC UA Client (Softing)  
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7.1.2 Evaluation procedure 
7.1.2.1 Connection with the Communication Board 
Connect the communication board and PC, [refer to 7.1.1 System Configuration]  
Power is supplied from communication board when PC and the USB serial of the communication board are 
connected. 

 

7.1.2.2 Setting up the IP address of PC 
(1) Set the IP address of PC. Open "Network Settings". 
 

 

Windows10 : Control panel->Network and Sharing Center->Change adapter settings 
 
 
(2) Select local area connection and select properties. 
 

 

 
 

Local Area connection 

properties 
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(3) Select “Internet Protocol Version 4(TCP/IPv4) and click on the [Properties] button. 
 

 

 
 
(4) Select the IP address and subnet mask in the area indicated by the red frame in the figure below. 
IP address setting example  : 192.168.0.xx 
Subnet mask setting example  : 255.255.255.0 
 

 

 
The setting up is complete. 

Internet 
Protocol 
Version 
4(TCP/IPv4) 

Properties 
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7.1.2.3 Starting OPC UA Client 
(1) From the Windows start up menu, start up the dataFEED. 
 

 

For information on install of dataFEED OPC UA Client refer to [Installation of 7.3 OPC UA Client]. 
 
 
(2) Click on the upper left, [Double click to added session]. 
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(3) Session Connect screen is displayed, enter the following information and click on OK. 
 

- Session Name：Any session name (ex：dataFEED OPC UA Client 1) 

- Endpoint URL：Endpoint の URL（ex：opc.tcp://192.168.0.55:4880/Renesas/MicroUaServer） 

- Security Mode: None 

- Security Policy: None 

- Message Encoding: Binary 

 

 

 
 

(3) Check whether the text at the bottom of the window has been [Active].The connection with the OPC UA 
Server is complete. 
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7.1.2.4 Reading out the data and Writing data of OPC UA Server 
 

(1) Method of reading data 
 

① Open the Configuration Browse tab and select the browse name of the data want to read. 
(ex.Line_Fan1_RotasSpeed) 

② The data sent from the OPC UA Server is displayed in the Value window at the lower right of the screen. 

③ The data is updated each time you click on the notepad icon at the bottom right of the Value window. 
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(2) Method of writing data 
 

① Open the [Configuration Brows tab]and select the browse name. (ex.Preset_Zone1_Temp) 
 

② Check the [Access Level] displayed  on Variable Attributes is [3]. 

【Access Level】 

1：only reading out / can be read out and written 

（Change of Access Level can be configured by constructing the address area.） 

 

③ It is written when pressing the Enter key or selecting the pencil mark at the upper right of the Value window. 

 

④ Check that the value written in "Value" is displayed and  is displayed. 
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7.2 Setting IP address and port number 
To change the IP address and port number of the communication board, change 
[APPLICATION/AppServer/appserver_ip_address.h] in this sample proglam. 
 

■ If want to change the IP address. 
① Enter the IP address in NETCONFIG_IP_ADDRESS as a string. 
② Enter the IP address in hexadecimal in NETCONFIG_IP_ADDRESS. 

Ex.) If IP address is "192.168.0.32" 

#define NETCONFIG_IP_ADDRESS            "192.168.0.32" 

#define NETCONFIG_IP_ADDRESS_BIN        0xC0A80020 
 
■ If want to change the Subnet Mask 
① Enter Subnet Mask as a string in NETCONFIG_NET_MASK. 

② Enter Subnet Mask in hexadecimal in NETCONFIG_NET_MASK. 

Ex.) If Subnet Mask is "255.255.255.0" 

#define NETCONFIG_NETMASK               "255.255.255.0" 
#define NETCONFIG_NETMASK_BIN           0xFFFFFF00 

 
■ If want to change the Port number 
③ Enter the port number in decimal in NETCONFIG_ PORT_NUMBER. 

Ex.) If Port number is 4840 

#define NETCONFIG_PORT_NUMBER           4840 
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7.3 Installing OPC UA Client 
7.3.1 Downloading of dataFEED OPC UA Client 
You need to register an account when downloading dataFEED OPC UA Client of Softing. 
Register an account from the following URL and downloading. 

Softing : https://company.softing.com/en/startpage.html 

 

7.3.2 Installing dataFEED OPC UA Client 
① Start the installer (InstallDataFFEDOpcUaClientxxx.exe), Clic on [Next>](xxx: Version) 

 

 

 
② Select [I accept the terms in the license agreement] and click on the [Nexst>] button. 

 

 

 
  

https://company.softing.com/en/startpage.html
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③ Click on the [Install] and start the installation. 

 

 

 
④ When the installation is complete, the view results screen is displayed and click on the [Finish] . 
 

 

 
⑤ A shortcut of 「dataFEED OPC UA Client」is created on the desktop. 

dataFFED of installation is completed. 
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General Precautions in the Handling of Microprocessing Unit and Microcontroller 
Unit Products 
The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 
2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 
3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 
4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 
5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 
6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 
7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 
8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 

 
 
 ・Arm® and Cortex® are registered trademarks of Arm Limited (or its subsidiaries) in the EU and/or elsewhere.  

All rights reserved.  
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Notice 
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products 

and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your 
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use 
of these circuits, software, or information. 

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, 
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this 
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.  

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics 
or others. 

4. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any 
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering. 

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for 
each Renesas Electronics product depends on the product’s quality grade, as indicated below. 
 "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home 

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc. 
 "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key 

financial terminal systems; safety control equipment; etc. 
Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas 
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to 
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space 
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics 
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product 
that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document. 

6. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for 
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by 
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas 
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such 
specified ranges. 

7. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific 
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability 
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics 
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily 
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as 
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for 
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are 
responsible for evaluating the safety of the final products or systems manufactured by you. 

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas 
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of 
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these 
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance 
with applicable laws and regulations. 

9. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is 
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations 
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions. 

10. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or 
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document. 

11. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics. 
12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas 

Electronics products. 

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled 
subsidiaries. 

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 
 

(Rev.4.0-1  November 2017) 
 

Corporate Headquarters  Contact information 
TOYOSU FORESIA, 3-2-24 Toyosu, 
Koto-ku, Tokyo 135-0061, Japan 
www.renesas.com 

 For further information on a product, technology, the most up-to-date 
version of a document, or your nearest sales office, please visit: 
www.renesas.com/contact/. 

Trademarks   
Renesas and the Renesas logo are trademarks of Renesas Electronics 
Corporation. All trademarks and registered trademarks are the property 
of their respective owners. 
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